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The Processor: Datapath & Control

2 We're ready to look at an implementation of the MIPS

2 Simplified to contain only:
® memory-reference instructions: 1w, sw

e arithmetic-logical instructions: add, addu, sub, subu,
and, or, xor, nor, slt, sltu

e arithmetic-logical immediate instructions: addi, addiu,
andi, ori, xori, slti, sltiu

@ control flow instructions: beq, 1

2 Generic implementation:

® use the program counter (PC) to supply
the instruction address and fetch the
instruction from memory
(and update the PC)

@ decode the instruction (and read registers)
@ execute the instruction
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Abstract Implementation View

2 Two types of functional units:

e elements that operate on data values (combinational)

e elements that contain state (sequential)

Instruction
Memory

P »Address Instructiorn

»\\Vrite Data

Register

»Reg Addr

File

»Reg Addr

»Reg Addr

Read

Data

Read

™

Data

%

» Address

Data
Memory Read Data

»\\Vrite Data

2 Single cycle operation
2 Split memory (Harvard) model - one memory for

instructions and one for data
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Fetching Instructions

2 Fetching instructions involves
@ reading the instruction from the Instruction Memory

® updating the PC value to be the address of the next
(sequential) instruction

clock | l )Ad
4 —p
!m Instruction
Memory
Exec Decode
> P » Read INStructiorfe—p

" |Address

e PC is updated every clock cycle, so it does not need an
explicit write control signal

@ Instruction Memory is read every clock cycle, so it
doesn’t need an explicit read control signal
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Decoding Instructions

1 Decoding instructions involves

@ sending the fetched instruction’s opcode and function
field bits to the control unit

Fetch | Control
PC = PC+4 "\ Unit

R

Read Addr 1

\ 4

Register Read ——

Read Addr 2 Data 1
File
Write Addr

\ 4

Instruction

Read
Data 2

Write Data

@ reading two values from the Register File
- Register File addresses are contained in the instruction
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Reading Registers “Just in Case”

2 Note that both RegFile read ports are active for all
Instructions during the Decode cycle using the rs and
rt instruction field addresses

® Since haven't decoded the instruction yet, don’t know what
the instruction is !

® Just in case the instruction uses values from the RegFile
do “work ahead” by reading the two source operands

Which instructions do make use of the RegFile values?
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EX:

2 All instructions (except ) use the ALU after
reading the registers. Please analyze memory-
reference, arithmetic, and control flow
Instructions.
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Executing R Format Operations

2 R format operations (add, sub, slt, and, or)
31 25 20 15 10 5 0

R-type:| op | rs | rt |rd |shamt| funct

e perform operation (op and funct) on values in rs and rt
@ store the result back into the Register File (into location rd)

RegWrite ALU control
»Read Addr 1 \l
Fetch Register DIZteaa? >
PC =PC+4 Instruction *|Read A(;(_jlr 2 > —> overflow
ille — Zelro
: ALU
@ Decode »\Write Addr Read ,
_ Data 2
»\\Vrite Data

® Note that Register File is not written every cycle (e.g. sw), so
we need an explicit write control signal for the Register File
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Consider the s1t Instruction
2 Remember the R format instruction s1t

slt St0, $s0, $sl1 # if SsO0 < $sl
# then St0 =1
# else St0 = 0

® Where does the 1 (or 0) come from to store into $t0 in the
Register File at the end of the execute cycle?

RegWrite ALU control
» Read Addr 1 \l
Register DIZteaa? >
Instruction »Read A‘;‘_jlr 2 > — overflow
e — Zero
: ALU
»\Write Addr Read ‘
) Data 2 -
»\\Vrite Data
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Executing Load and Store Operations
2 Load and store operations have to

31 25 20 15 0

I-Type: op |rs |rt | address offset

® compute a memory address by adding the base
register (in rs) to the 16-bit signed offset field in the
Instruction

- base register was read from the Register File during
decode

- offset value in the low order 16 bits of the instruction
must be sign extended to create a 32-bit signed value

e store value, read from the Register File during
decode, must be written to the Data Memory

e load value, read from the Data Memory, must be
stored in the Register File
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Executing Load and Store Operations, con’t

RegWrite ALU control MemWrite
l overflow l
»IRead Addr 1 Zero
Register Dlzfaa? — —p Address
Instruction >Read A(:(_jlr 2 > Data
e ‘ Read Data
. ALU Memory
»\Write Addr Read
Data 27 —=p{\\Vrite Data
»\\Vrite Data
. Sign MemRead
‘416 | Exten 32
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Executing Branch Operations

2 Branch operations have to
31 25 20 15 0

I-Type: op |rs |rt | address offset

@ compare the operands read from the Register File
during decode (rs and rt values) for equality (zero

ALU output)

e compute the branch target address by adding the
updated PC to the sign extended16-bit signed
offset field in the instruction

- “base register” is the updated PC

- offset value in the low order 16 bits of the instruction
must be sign extended to create a 32-bit signed
value and then shifted left 2 bits to turn it into a word
address
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Executing Branch Operations, con’t
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Instruction

\ 4

\ 4

Read Addr 1
Register Read

> Branch

> Ad target
address

ALU control

zero (to branch
— control logic)

Read Addr 2 Data 1
File

Write Addr Read

>ALU

Data 2

Write Data

\ Sign

‘416 | Extend ‘39
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Executing Jump Operations
2 Jump operations have to

J-Type:| op jump target address

@ replace the lower 28 bits of the PC with the lower 26 bits
of the fetched instruction shifted left by 2 bits

PC|
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Creating a Single Datapath from the Parts

1 Assemble the datapath elements, add control lines
as needed, and design the control path

0 Fetch, decode and execute each instruction in one
clock cycle — single cycle design

® no datapath resource can be used more than once per
instruction, so some must be duplicated (e.g., why we
have a separate Instruction Memory and Data Memory)

e to share datapath elements between two different
instruction classes will need multiplexors at the input of
the shared elements with control lines to do the
selection

0 Cycle time is determined by length of the longest
path
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Fetch, R, and Memory Access Portions

v

>Ad

4 —p

Instruction
Memory

Read

Instructiorn

v
)
y

“|Address
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RegWrite
» Read Addr 1
. Read
Register
»[Read Addr 2 Data 1
File
»\Write Addr Read

ALU control

:

vf
Tzero

MemWrite

l

Address

\ 4

Data
Memory Read Data

Write Data

Data 2
\Write Data

\ Sign
\
16 Extend 32

T
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Multiplexor Insertion

)Ad RegWrite ALUSrc ALU control MemWrite MemtoReg
4 > l ovf l
TZGI’O
. »Read Addr 1
Instruction . Read » Address
Memory ReglsterD 1
»Read Addr 2 Data Data
> PCcH—p{Read Instructior] File v — Memory Read Dataf—»
Address » Write Addr
Rea
Data 2 Write Data
h[Write Data
_ MemRead
\ Sign
\16 Extend 32
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Clock Distribution

System Clock

clock cycle

\ 4

4

RegWrite

ALUSrc ALU control

:

Instruction »Read Addr 1 Read
Memo Register
v »[Read Addr 2 Data 1
> P Ci—p E\ceig:jess Instructiorn] _ File
»\Write Addr Rea
) Data 2
h[erte Data
\ Sign

vf

TZG ro

MemWrite

Address

\ 4

Data
Memory Read Data

Write Data

\16 Extend 32

MemtoReg

\ 4

T

MemRead
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Adding the Branch Portion

\ 4

»

\ 4

»

v
)
y

Read
“|Address

Instruction
Memory

Instructiorn

YAd

ovf
Tzero
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RegWrite
» Read Addr 1
. Read
Register
»Read Addr 2 Data 1
File
»\Write Addr Read
] Data 2
b[erte Data

\ 4

ALUSrc ALU control

PCSrc
MemWrite

l

Address

MemtoReg

\ 4

Data
Memory Read Data

\ 4

Write Data

*16 @ ‘32

T
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Our Simple Control Structure
2 We wait for everything to settle down

@ ALU might not produce “right answer” right away

® Memory and RegFile reads are combinational (as are
ALU, adders, muxes, shifter, signextender)

® Use write signals along with the clock edge to determine
when to write to the sequential elements (to the PC, to
the Register File and to the Data Memory)

2 The clock cycle time is determined by the logic
delay through the longest path

We are ignoring some detalils like register
setup and hold times
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Summary: Adding the Control

0 Selecting the operations to perform (ALU, Register
File and Memory read/write)

2 Controlling the flow of data (multiplexor inputs)

2 Information comes from the 32 bits of the instruction
31 25 20 15 10 5 0

2 Observations  R-type:| o | rs | rt |rd |shamt| funct

e op field always

in bits 31-26 31 20 20 15

e addroftwo  I-Type: | o5 | rs | rt | address offset

reqgisters to be
read are always specified by the
rs and rt fields (bits 25-21 and 20-16)

® base register for lw and sw always in rs (bits 25-21)

@ addr. of register to be written is in one of two places —in rt
(bits 20-16) for Iw; in rd (bits 15-11) for R-type instructions

e offset for beq, lw, and sw always in bits 15-0
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(Almost) Complete Single Cycle Datapath

\ 4

»

v

) Ad
4 :) @

RegDst RegWrite ALUSTrc

l

Instr[25:21]
Instruction Read Addr 1

. Read
Memory INSt20116] |2 e e Data 1

A

v
U
y

16}
N T ) LS File
Address 1 Write Addr o

Tnstr[T _ Data 2
-11] > Write Data

YAd

oVizarg

v
o

1

PCSrc

MemWrite MemtoReg

l

—ptAddress

Data
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v

linstr[15-4] \ Sign |\ | —
\ \
16 Extend 32

Instr[5-0]

MemRead

T
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ALU Control

2 ALU's operation based on instruction type and function

code

2 Notice that we are using different encodings than in

the book
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ALU control Function
iInput
0000 and
0001 or
0010 xor
0011 nor
0110 add
1110 subtract

1111

set on less than

Spring 2018



EX: ALU Control, Con’t

2 Controlling the ALU uses of multiple decoding levels
® main control unit generates the ALUOp bits
® ALU control unit generates ALUcontrol bits

Instrop | funct | ALUOp| action | ALUcontrol
lw XXXXXX 00

SW XXXXXX 00

beq XXXXXX 01

add 100000 10 add 0110
subt 100010 10 subtract 1110
and 100100 10 and 0000
or 100101 10 or 0001
xor 100110 10 Xor 0010
nor 100111 10 nor 0011
slt 101010 10 sit 1111
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ALU Control Truth Table

Our ALU m control input

—  ——

FS|F4 | F3|F2 | F1|FO| ALU | ALU M ALU ﬁU\

Op; Op, Wntrolz control, | co 5
X|X|X|X[X|X] 0| 0| /o 1 N0
X|XIXIX[X[X] 0| 1 [[1) 1 0\
X[Xx[ojojo|o| 1 [0 [|[o]]|/1 1 0 \
X[X[0]0[1][0] 1 | 0 |]1 1 1 0
X[Xx[jo[1]o0]0o] 1 | 0 []oO 0 | O
X[X[o[1]o0[1] 1 ] o [lo][lo | o 1
X[x[o[1]1]0] 1 [ 0o [|lo]|\o 1 0/
X|X[o[1]1|1| 1 | 0 ]\o 1 1/
X[ x[1]ol1]o] 1 ] o | \4 1 L

2 Four, 6-input truth tables
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ALU Control Logic
2 From the truth table can design the ALU Control logic

Instr[3]
Instr[2]
Instr[1]
Instr[0]
ALUOp,
ALUOp,

VOIQUUG

ALUcontrol,

ALUcontrol,

ALUcontrol,

VY

ALUcontrol,
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Almost) Complete Datapath with Control Unit

\ 4

)Ad R
>Ad
4 —p >
PCSrc
ALUOD Branch
MemRead
Instr[31-26] Control MemioReg
Unit Memvvriie
\/ ALUSrc
RegWrite
RegDst
ovf
\ 4 T \ 4
Instruction IInstr[25-21L Read Addr 1
Redqister Read —ptAJdress
Memory Instr{20.161 ISt Data 1 zer
» Read Addr 2 Data y
Read :
»PCt-L—p Instr[31-0]== 0 File Memory Read Dataf—»|1
Address Write Addr S v
1 €a )
Flnstr[1 Wiite Dat Data 2 Write Data 0
1] —i[ rite Data _
Instr{15-9] \ @ \ —
. N Extend/| ALU
16 U 32 contro
Instr[5-0]
Spring 2018
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R-type Instruction Data/Control Flow
= {
Ad >
PAd
4 ——p [
PCSrc
ALUOD, Branch
MemRead
Instr[B1-26] Control MemioReg
Unit MemWVrite
\/ ALUSrc
RegWrite
RegDst
V1 OVf VO
Instruction Instr[25-21L Read Addr 1 T
Redaist Read —ptAJdress
Memory Iinstr[20116] SISt hata 1 zer
» Read Addr 2 Data y
Read : )
» PC—— Instr[31-0}=- File Read Dat >

Address "S1510) - Write Addr ALU Memory Fead =

h Rea 0 5
Write Data
Instr[ , Data 2
1] —b[Wnte Data
A
0
Instr[15-0] \ @ \ ALU
\16 @ \32 contro
Instr[5-0]
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Store Word Instruction Data/Control Flow

N [
» KO
Ad >
PAd 1
4 ——p [
PCSrc
ALUOD Branch
MemRead
Instr[B1-26] Control MemioReg
Unit MemVvVrite
\—/ ALUSrc
RegWrite
RegDst
VO OVf V1
. Instr[25:21] |Read Addr 1 |
Instruction Read Add
Memory S Register ea Address
nstf20:16}|Read Addr 2 Data 1 zer Data .
Read : 3
»PC-—p Instr[31-0]-- 0 File >AL Memory Read Data—»
Address i u ry
h 1 Write Addr Read R)K
Write Data
1] —h[erte Data AO
lInstr[15-9] \ @ \ ™/ ALU
*16 @ '32 contro
Instr[5-0]
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Load Word Instruction Data/Control Flow

> /[
> \0
Ad >
PAd 1
4 \
PCSrc
ALUOD Branch
MemRead
Instr[31-26] Control VemioReg
Unit MemVvrite
\/ ALUSrc
RegWrite
RegDst
v1 ovf 0
Instruction Instrl25-21} \Read Addr 1 T
Memo Register Read —pAddress
Y Inst[20-16] Read Addr 2 Data 1 zer Data r
Read . ’
»PCH—p Instr[31-0}=- File Read Dat
Address nstrl 1 0 Write Addr ALU Memory Read Data—+t
1 Rea 0 .
ilnstr[1 Wiite Dat Data 2 Write Data 0
1] —i[ rite Data
A
1
.In—Str[15' )] \ @ \ > ALU
16 @ '32 contro
Instr[5-0]
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Branch Instruction Data/Control Flow

Ad >
Ad
4
PCSrc
ALUOp, B@
~ MemRead
Instr[31-26] Control VemioReg
Unit MemWVrite
\—/ ALUSrc
RegWrite
RegDst
"O O\T/f VO
Instruction Instrl25-211 Read Addr 1
Memo Register ¢ad —nAddress
e Instr[20-16] Read Addr 2 Data 1 er Data |
Read : )
» PC-— Instr{31-0]=- File > Read Dat >
Address M3l Vlwrite Ada: ALU Memory Read Data
1 Read 0 _
ilnstr[1 Wiite Dat Data 2 i Write Data 0
1] —>Write Data
A
m 0
lInstr[15-9] \ Sign |\ | —/ ALU
16 @ '32 contro
Instr[5-0]

CENG3420 L06.31 Spring 2018



Main Control Unit

Instr RegDst| ALUSrc | MemReg | RegWr | MemRd | MemWr |Branch| ALUOp
R-type | 1 0 0 1 0 0 0 10

000000

lw 0 1 1 1 1 0 0 | 00

100011

SW X 1 0 0 1 0 | 00

101011

beq X1 0 0 0 0 1 01

000100
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Control Unit Logic
2 From the truth table can design the Main Control logic

Instr[31]
Instr[30]
Instr[29]
Instr[28]
Instr[27]
Instr[26]

L

R-type 1w SW be
yp 4 RegDst

ALUSrc
MemtoReg
RegWrite
MemRead
MemWrite

U

Branch
ALUOp;
ALUOp,
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Review: Handling Jump Operations

2 Jump operation have to

@ replace the lower 28 bits of the PC with the lower 26 bits
of the fetched instruction shifted left by 2 bits

J-Type:| op jump target address

) ] Jump
address
28

PC S
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Adding the Jump Operation

Instr[25-\0] shife—\ (
i
28 32 _
> 26 \left 2 > 0\
PC+4[31-28]
Ad . >0
Y Add—»!1
—>‘—> PCSrc
Jump
ALUO Branch
MemRead
Instr| Control MemioReg
Unit MemVVrite
\/ ALUSrc
RegWrite
RegDst
VO O\T/f VO
Instruction instizo:2ThRead Addr 1
Memo Register ¢ad —nAddress
ry Instr[20+16] Data 1 zer
‘ »Read Addr 2 Data y
Read ;
»PCH-—> Instr[31-0] File Memory Read Dataf—»|1
Address | priwite Addr g ALU v
Write Data 0]
Instr[1 , Data 2
1] —b[erte Data _
0
linstr[15-9] \ @ \
\ \
16 @ 32
Instr[5-0]
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EX: Main Control Unit of j

Instr RegDst| ALUSrc | MemReg | RegWr | MemRd | MemWr |Branch| ALUOp | Jump
R-type | 1 0 0 1 0 0 0|10 | O
000000

lw 0 1 1 1 1 0 0O 00| O
100011

SW X 1 0 0 1 0O | 00| O
101011

beq X1 0 0 0 0 1 | 01 0
000100

J 1
000010
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Single Cycle Implementation Cycle Time

2 Unfortunately, though simple, the single cycle
approach is not used because it is very slow

2 Clock cycle must have the same length for every
iInstruction

2 What is the longest path (slowest instruction)?
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EX: Instruction Critical Paths

0 Calculate cycle time assuming negligible delays (for
muxes, control unit, sign extend, PC access, shift left 2,

wires) except:
@ Instruction and Data Memory (4 ns)
e ALU and adders (2 ns)
@ Register File access (reads or writes) (1 ns)

Instr. | | Mem | RegRd | ALU Op | D Mem | Reg Wr| Total

R- 4 1 2 1 8
type
load

store

beq

jump

CENG3420 L06.38 Spring 2018



Single Cycle Disadvantages & Advantages

2 Uses the clock cycle inefficiently — the clock cycle
must be timed to accommodate the slowest instr

@ especially problematic for more complex instructions like
floating point multiply

_ Cycle 1 n Cycle 2 d
Clk I I |

Iw I sSwW : Waste

2 May be wasteful of area since some functional units
(e.g., adders) must be duplicated since they can
not be shared during a clock cycle

but
2 1t is simple and easy to understand
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